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Data Quality using coded lists, recording measures

The Tool Box is a suite of tools for recording patient readings, either calculated 
manually or via a Diagnostic Devices, with each tool provided on a separate tab as 
shown in the following image.

The upper section of this window provides a means to;

o Mark the date and time on which the recordings were taken, and

o Test the tools using fictitious data (Sex at Birth and Age). Note that although you 
can change the patient's sex at birth and age here, these changes are not saved back 
to their record.

The lower section displays a selection of tool tabs. Some tabs require that you enter 
general data before recordings can be made. You will be prompted accordingly when 
this is necessary.

Blood Glucose
Blood Pressure
Cardiovascular Risk - Absolute Calculator
Cardiovascular Risk - Relative Calculator
Electrocardiogram
INR Record
Paediatric Percentile Charts
Renal Function Calculator
Respiratory Function
Weight

https://www.medicaldirector.com/help/topics-maintenance/Device_List.htm
https://www.medicaldirector.com/help/topics-clinical/Sex_at_Birth.htm
https://www.medicaldirector.com/help/topics-clinical/Blood_Glucose.htm
https://www.medicaldirector.com/help/topics-clinical/Blood_Pressure.htm
https://www.medicaldirector.com/help/topics-clinical/Cardiovascular_Risk_Calculator_Absolute_CVD_Risk.htm
https://www.medicaldirector.com/help/topics-clinical/Cardiovascular_Risk_Calculator_Relative_CVD_Risk.htm
https://www.medicaldirector.com/help/topics-clinical/Electrocardiogram.htm
https://www.medicaldirector.com/help/topics-clinical/INR_Record.htm
https://www.medicaldirector.com/help/topics-clinical/Paediatric_Percentile_Charts.htm
https://www.medicaldirector.com/help/topics-clinical/Renal_Function_Calculator.htm
https://www.medicaldirector.com/help/topics-clinical/Respiratory_Function.htm
https://www.medicaldirector.com/help/topics-clinical/Weight.htm
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Data Quality using coded lists, recording measures via Progress Notes
The Examination module of Progress 
Notes allows you to record the findings of a 
single consultation. Each tab within the 
Examination module contains a variety of 
controls for recording information, as shown in 
the following image.

Some data may also be appear automatically on 
this window, if it was recorded previously using 
other components of Clinical, such as the Blood 
Pressure module.

Information recorded using any of the tools 
within the Examination module appears in the 
text box at the upper-left of the window, and 
upon saving is added to the Progress Note for 
the consultation.

The content available to this module differs 
depending on the patient's recorded sex at birth.

https://www.medicaldirector.com/help/topics-clinical/Progress_Notes.htm
https://www.medicaldirector.com/help/topics-clinical/Progress_Notes.htm
https://www.medicaldirector.com/help/topics-clinical/Blood_Pressure.htm
https://www.medicaldirector.com/help/topics-clinical/Blood_Pressure.htm
https://www.medicaldirector.com/help/topics-clinical/Progress_Notes.htm
https://www.medicaldirector.com/help/topics-clinical/Sex_at_Birth.htm
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CVD (Cardiovascular Risk Calculator) Absolute Calculator
1. From within the Clinical Window, select Tools > Tool Box > Cardiovascular Risk. The CV Risk tab appears. Select which calculator you wish 

to use. If you select the Absolute calculator, the following fields will be pre-populated with data, where available:

o Sex at Birth. As sourced from the patient's record.

o Age. As sourced from the patient's record.

o Systolic blood pressure. As sourced from the most recent blood pressure 'sitting' data, recorded within the last 2 months.

o Diastolic blood pressure. As sourced from the most recent blood pressure 'sitting' data, recorded within the last 2 months.

o Smoking status. A patient who has quit smoking within the last year will be considered a smoker for the purposes of the calculator.

o Total Cholesterol. As sourced from the most recent Total Cholesterol data, recorded within the last 2 months.

o HDL Cholesterol. As sourced from the most recent HDL Cholesterol data, recorded within the last 2 months.

o Diabetes. As sourced from the patients past medical history, see Absolute CVD Risk Diagnosis Descriptions.

2. Options:

o For patients who are automatically considered 'high risk', simply click Save button to automatically document the risk value as >15% in the 
Tool Box. This will also add a note to the patient's Progress Notes. There are no further actions required. You may exit the Tool Box.

o For all other patients, click Absolute CVD Risk Calculator button. Proceed now to Step 3.

3. Enter values for the following fields:

o Systolic Blood Pressure - (Enter a value between 50 and 300).

o Diastolic Blood Pressure - (Enter a value between 20 and 150).

o Total Cholesterol - (Enter a value between 2 and 30).

o HDL Cholesterol - (Enter a value between 0.2 and 20).

4. Indicate the patient's smoking and diabetes status, and ECG LVH. Note that this is not the same as 'echo LVH' which is a lesser risk factor.

5. Click Save button. A new entry appears within the recorded data on the right-hand side of this window. Note that this data is saved to this 
window for future reference, and a record is made in the patient's Progress Notes.

o Low risk: Less than 10% probability of cardiovascular 
disease within the next 5 years.
o Moderate risk: 10–15% risk of cardiovascular disease 
within the next 5 years.
o High risk: Greater than 15% risk of cardiovascular disease 
within the next 5 years.

https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/Tool_Box.htm
https://www.medicaldirector.com/help/topics-clinical/Pt_Details_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Pt_Details_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Blood_Pressure.htm
https://www.medicaldirector.com/help/topics-clinical/Blood_Pressure.htm
https://www.medicaldirector.com/help/topics-clinical/Absolute_Cardiovascular_Risk_Calculator_DOCLE_Codes.htm
https://www.medicaldirector.com/help/topics-clinical/Cardiovascular_Risk_Calculator_Absolute_CVD_Risk.htm?rhhlterm=CVD%20Risk%20Assessment&rhsyns=%20#Interpreting_the_Results
https://www.medicaldirector.com/help/topics-clinical/Progress_Notes.htm
https://www.medicaldirector.com/help/topics-clinical/Progress_Notes.htm
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Recording Cervical Screening via the Patient’s Record
1. Select the Cervical Screening tab in the patient's clinical record.

2. Either,

o Click
o Press F3
o Right-click within the list of recorded screens and select New 
Item from the menu that appears

3. The Record Cervical Screening Result window appears.

o Enter the date on which the screen was obtained from the 
patient.
o Select a result type from the list provided.
o Tick check boxes as appropriate to indicate whether 
Endocervical cells and/or H.P.V. changes were present.

o If you wish to generate a Recall notification for this patient, 
click Add Recall

4. Click Add to confirm and save your data.

https://www.medicaldirector.com/help/topics-clinical/Cervical_Screening_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/Recalls.htm
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Recording Cervical Screening via the Holding File

4. Then, select File > Add Cervical Screening Result. 
The Record Cervical Screening Result window appears.
o Enter the date on which the screen was obtained from the 
patient.

o Select a result type from the list provided.

o Tick check boxes as appropriate to indicate whether 
Endocervical cells and/or H.P.V. changes were present.

o If you wish to generate a Recall notification for this patient, 
click Add Recall

5. Click Add to confirm and save your data. The result is added to 
the Cervical Screening tab of the patient's record.

1. Select Correspondence > Check Holding File to open the Holding File.

2. From this window select which recipient will request the Cervical Screening.

3. Once within the Holding File, locate and select the patient for whom you wish to manually 
record a cervical screening.

https://www.medicaldirector.com/help/topics-clinical/Recalls.htm
https://www.medicaldirector.com/help/topics-clinical/Cervical_Screening_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Holding_File.htm
https://www.medicaldirector.com/help/topics-clinical/Cervical_Screening.htm
https://www.medicaldirector.com/help/topics-clinical/Filtering_Results_in_the_Holding_File.htm


TELSTRA HEALTH INTERNAL

Recording Cervical Screening via the Clinical Front Screen
1. From the Clinical Front Screen, select Clinical 
> Cervical Screen Results > Add Result. The Select Patient from 
List window appears.

2. Search for and open the patient record you want to add a 
result for. The Cervical Screening Result summary for the patient 
will appear.

o Only female or gender-neutral patients will appear in the list.

3. Click Add The Record Cervical Screening Result window 
appears.
o Enter the date on which the screen was obtained from the 

patient.
o Select a result type from the list provided.

o Tick check boxes as appropriate to indicate whether 
Endocervical cells and/or H.P.V. changes were present.

o If you wish to generate a Recall notification for this patient, 
click Add Recall

4. Click Add to confirm and save your data.

https://www.medicaldirector.com/help/topics-clinical/Opening_a_Patient_Record.htm
https://www.medicaldirector.com/help/topics-clinical/Pt_Details_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Recalls.htm
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National Cancer Screening Register

This enables the user to:

•Open the patient’s record and view their test results, summary of the outcome and screening histories;
•View the patient’s screening status and alerts;
•View the patient’s next screening eligible date;
•Generate cervical screening history report;
•Submit Program forms to the Register – cervical and bowel screening program forms;
•View and update the patient’s demographic details;
•Manage the patient’s screening participation, including opting out, resuming participation or deferring from 
either the bowel or cervical screening programs;
•Cease the patient’s correspondence for the cervical screening program; and
•Nominate other people to assist your patient (such as a personal representative or another Healthcare 
Provider).
For further assistance, you can call the contact centre on 1800 627 701. The contact centre operates Monday to 
Friday, between 8am and 6pm in all Australian state and territory time zones.

The National Cancer Screening Register enables a single electronic record for each person in Australia participating in cervical 
and bowel screening. The National Cancer Screening Register plays a vital role in supporting the National Cervical Screening 
Program (NCSP) and the National Bowel Cancer Screening Program (NBCSP). It gives healthcare providers access to their 
patients’ health information and makes it easier for program participants to take control of their health.

Healthcare providers that have integrated their Clinical Information System with the National Cancer Screening Register, are 
able to interact directly with the National Cancer Screening Register from their existing software using the NCSR widget.



TELSTRA HEALTH INTERNAL

National Cancer Screening Register – Bowel & Cervical Screening

1. For registered 
patients, the widget 
appears as follows 
with the NCSR 
History tab 
presented by 
default. This tab 
contains the 
patient's history of 
screening results 
retained within the 
National Cancer 
Screening Register.

2. Switch to 
the Choose Form & 
Report tab to 
select a 
form/report to 
submit.
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National Cancer Screening Register – Bowel & Cervical Screening

3. Complete and submit the form.
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Prescribing Select Drug

There are a number of ways you can prescribe medications, all of which can 
only be performed from within a patient's Clinical Window:

•Select the Current Rx tab and then to add a new item, click or press F3 or 
right-click within the current medications list and select New Item from the 
menu. The Select Drug window appears. Proceed to Step 1 below, or
•To back-date a script, select the Current Rx tab and then to add a new item, 
enter the 'Script Date' as required at the bottom of the Current Rx tab, 
click      or press F3 or right-click within the current medications list and select 
New Item from the menu. The Select Drug window appears. Proceed to Step 1 
below, or
•Prescribe from your Drug Favourites list (should you have any favourites 
saved), by clicking   in the toolbar. The Select Drug window appears. 
Proceed to Step 1 below, or
•Select a medication from within MDref. Within in MDref, highlight the item 
you wish to prescribe and then click Prescribe button at the bottom-left of the 
MDref Explorer window. The Enter Dose window appears. Proceed to Step 2 
below, or
•Select from any Drug Protocols you have created. Proceed to Step 12 below, 
or
•Re-prescribe from the patient's old scripts. Select the Old Scripts tab, located 
and right-click the item you wish to re-prescribe, and select Prescribe Item 
from the menu that appears. Proceed to Step 2 below.

1. The Select Drug window appears.
Select an item by either:

o Typing the name of the medication into the Enter Drug Name text box (you 
need only type the first few letters for a search to commence), and double-
clicking the drug or selecting the drug and clicking Prescribe button

https://www.medicaldirector.com/help/index.htm#t=topics-clinical%2FPrescribing.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/Current_Rx_(Medications)_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Current_Rx_(Medications)_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Medication_Favourites.htm
https://www.medicaldirector.com/help/topics-clinical/Drug_Protocols.htm
https://www.medicaldirector.com/help/topics-clinical/Old_Scripts_Tab.htm
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Prescribing Selecting Drug by Class
2. (Optional) You can further filter the list of medications by:

o Ticking the Exclude OTC... check box to refresh the medications list to 
hide Over-The-Counter medications,

o Clicking Brands Button to show generically equivalent brand names 
with the same strength as the highlighted item,

o Clicking Group button to display all members of the Therapeutic Group 
to which the selected medication belongs. This button is only available to 
medications that belong to a Therapeutic Group,

o Clicking Current Class button to display all items from MDref that are 
in the same therapeutic class as the highlighted item.

o Right-clicking a medication, and selecting the 'Single and Multi-
Ingredient Products' option, which allows you to see other medications that 
contain at least one of the same ingredients of the selected medication. 
See Single and Multi-Ingredient Products for more information.

3. Click Prescribe button to prescribe your medication of choice.

4. (Optional) Once you have selected the medication, you may be notified 
of any possible drug interactions.

5. (Optional) If you have an existing Limited Prescription for this patient, 
a prompt is displayed. Select the most suitable option for your patient to 
continue.

o Accessing the MDref Class Browser by clicking Select drug by class button and selecting 
a drug from there

o Displaying your favourites list by clicking

 on the Select Drug window, and selecting a drug from the list that appears

• PBS - Pharmaceutical Benefits Scheme

• RPBS - Restricted Pharmaceutical Benefits Scheme

• B.P.P. - Brand Price Premium

• T.G.P. - Therapeutic Group Premium

• S.P.C. - Special Patient Contribution

https://www.medicaldirector.com/help/topics-clinical/MDref_and_the_MDref_Explorer.htm
https://www.medicaldirector.com/help/topics-clinical/single_and_Multi-Ingredient_Products.htm
https://www.medicaldirector.com/help/topics-clinical/Medication_Favourites.htm
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Drug Notifications

PBS/RPBS Codes

PBS Pharmaceutical Benefits Scheme unrestricted benefit

RB Pharmaceutical Benefits Scheme restricted benefit

AUTH Pharmaceutical Benefits Scheme Authority required

sAUTH Pharmaceutical Benefits Scheme Streamlined Authority required

Sect. 100 Pharmaceutical Benefits Scheme Section 100 item

RPBS RB Repatriation Pharmaceutical Benefits Scheme restricted benefit

RPBS 
AUTH

Repatriation Pharmaceutical Benefits Scheme Authority required

$-Rx Private prescription

$-OTC Product available without prescription

$-HOSP Available only through hospital pharmacies

Medicare Item payable as a Medicare benefit

SAS Special Access Scheme item

Unregis'd Product not registered with TGA
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Authority Items
If a prescribed medication item requires an Authority, during the prescribing process an additional step is required; after the 
'Dose/Frequency/Instructions' window has been completed, another window displays all the information that is required to obtain an 
Approval Number (by telephone).

o The Authority Number displayed is the 'Script Number', which must be quoted if you are required to (or choose to) obtain telephone 
approval.

o The Approval Number can be entered manually into the Approval Number text box if you are required to telephone for an approved 
number. Alternatively, using Medicare Australia's Streamlined Authority system, an Approval Number may be generated automatically for 
eligible medications. You can always change this number if you need to use a different Approval Number. Once changed manually, clicking 
Use Default Number button will reset the Approval Number to the default as dictated by Medicare Australia's Streamlined Authority 
system.

o If an Approval Number is entered, it is printed on the prescription. If it is not entered immediately, and telephone approval is 
subsequently obtained, it can be hand-written on the prescription in the appropriate places after the prescription has been printed.

o Some medications deemed eligible for Medicare Australia's Streamlined Authority system have multiple Approval Numbers associated 
with them that you can choose from. When these medications are prescribed, a View List button appears (in place of Use default number 
button shown in the image. On clicking View List button you will be presented with the Available Approvals window from which you can 
select an appropriate Approval Number.

o The quantity and number of repeats can be altered if necessary. For medications deemed eligible for Medicare Australia's Streamlined 
Authority system you can decrease the quantity and repeats without affecting the pre-generated Approval Number. Increasing these figures 
will require that you obtain an Approval Number.

o Check boxes are provided on this window to allow the Authority to be marked to indicate if a previous Authority has been obtained, 
and whether the prescription is to be sent to the patient or returned to the practitioner.

o Buttons allow you to choose whether the item is to be printed as an Authority prescription or as a Private prescription. If Private is 
chosen, the drug's code is changed from 'A' to '$', and it is printed on a private prescription.

o If Authority button is clicked, the item is printed as an Authority prescription. The text appearing in the edit box is printed on the 
Medicare Australia copy of the prescription as the Indication for Authority. This text can be edited if required. For example, some drugs 
require the date of an endoscopy to be added to the indication. In other cases, the same item may have multiple approved indications. The 
text should be edited so that the appropriate indication is displayed. When Authority button is clicked, the edited text is stored in that 
patient's record so that when subsequent Authority prescriptions are written, the text does not need to be re-edited.

o When the Authority prescription is printed, the third (Medicare Australia/DVA copy) and fourth (Practitioner's copy) copies of the 
prescription are printed on the white space below the original and duplicate. As MedicalDirector Clinical also keeps a copy of the 
prescription, it is not necessary for the prescriber to keep the printed fourth copy, however Medicare Australia requires it to be printed.

  o Because of space limitations, it is not possible to put lengthy instructions on authority prescriptions, and they are truncated to fit 
into        the available space.
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Prescribing Product Information, Prescribing options & more

6. The Enter Dose window appears. It is within this window that you record data about the 
dosage of the medication you are prescribing. You can also access Product Information about the 
medication via PI button.

7. Set the dosage (using the Dose Calculator if desired).

8. Select a frequency.

9. Indicate instructions as required, from either the list provided or by using stored text from the 
MedicalDirector Clinical Glossary.

10. Choose a Route of Administration from the list provided.

11. Select one of the Purpose of Action options, including:

o Product Advised here. Allows you to recommend a medication that does not require a script to 

be printed, such as cough syrup.

o Product Supplied here. Allows you to administer a medication without printing a script. For 
example, you may wish to administer a medication that you stock at your practice.

12. Select the Duration of Medication; Long Term or Limited. The default is Limited, which can be 
altered via Prescribing Options.

13. Long Term. Allows you to prescribe an on-going medication. When the medication runs out it is 
assumed it will be renewed (e.g. insulin injections for diabetes). Long Term medications remain 
on the Current Rx tab until manually deleted.

14. Limited. Allows you to issue the prescription for once-off or limited duration 
medication (e.g. cough medicine). Limited medications remain on the Current 
Rx tab even when the estimated duration expires, at which time a prompt will 
notify you of the cessation upon opening the patient's record.

https://www.medicaldirector.com/help/topics-clinical/Product_Information_(PI).htm
https://www.medicaldirector.com/help/topics-clinical/Dose_Calculator.htm
https://www.medicaldirector.com/help/topics-clinical/Stored_Text_MD_Glossary.htm
https://www.medicaldirector.com/help/topics-clinical/Route_of_Administration.htm
https://www.medicaldirector.com/help/topics-clinical/Prescribing_Options.htm
https://www.medicaldirector.com/help/topics-clinical/Current_Rx_(Medications)_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Deleting_or_Ceasing_Current_Medications.htm
https://www.medicaldirector.com/help/topics-clinical/Current_Rx_(Medications)_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Current_Rx_(Medications)_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Limited_Medication_Cessation_Prompt.htm
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Prescribing Active ingredient, Brand, Favourites & more

15. (Optional) Tick the MyHealthRecord Consent check box to indicate that you have the patient's consent to 
add details of this prescribed medication to the patient's My Health Record record. An indication of the 
patient's consent is displayed under the MyHealthRecord Consent column on the Current Rx tab.

This check box is only available if the following conditions have been met;

o You have enabled My Health Record

o You have enabled ePrescribing

This check box is ticked by default, unless the patient has set their record privacy to 'non-advertised' via the 
My Health Record consumer portal (a check for this setting is made upon opening the patient's record in 
MedicalDirector Clinical). If during the consultation the patient changes their mind, and grants consent to 
upload a given medication to their My Health Record, you can tick this check box now. Under such 
circumstances, patient consent must be granted per medication i.e. this check box will be un-ticked for 
subsequent medications until such a time as the patient logs onto the consumer portal and changes their 
record privacy.

Scripts approved for uploading to the My Health Record System in this manner are transferred when you print 
the script.

16. (Optional) Tick the Include Brand Name on Script check box if you wish to print the medication's 
associate brand name on the script. See Active Ingredient Prescribing for more information.

17. (Optional) Tick the Brand Substitution Not Allowed check box if required.

18. (Optional) Tick the Exclude from Active Script check box

19. (Optional) Tick the Script Owing check box to print a QR code to fax/email the pharmacy directly, instead 
of handing to the patient.

20. (Optional) Tick the Add to Favourites check box to add the drug to a favourites list, which is accessible 
when prescribing via 

21. (Optional) Ticking the Save as Default check box saves the dosage, instructions and 
duration so they are available next time the drug is selected.

22. Record the start date of the medication. The default date is the current date.

23. Click OK button when you are ready to continue.

https://www.medicaldirector.com/help/topics-clinical/MyHealthRecord.htm
https://www.medicaldirector.com/help/topics-clinical/Current_Rx_(Medications)_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/MyHealthRecord.htm#Configuring_Medical_Director_for_PCEHR
https://www.medicaldirector.com/help/topics-clinical/ePrescribing_Configuration.htm
https://www.medicaldirector.com/help/topics-clinical/Active_Ingredient_Prescribing.htm
https://www.medicaldirector.com/help/topics-clinical/Medication_Favourites.htm
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Prescribing Drug Quantity & Repeats

25. You will be prompted to confirm the drug 
quantity and repeats. Modify if necessary and click 
OK button to continue.

This prompt will differ slightly, depending on 
whether you are prescribing a limited or regular 
medication. It is possible to disable the prompt for 
regular medications via Prescribing Options.

26. (Optional) If you are prescribing a PBS/RPBS 
Restricted Benefit medication, you will be 
prompted accordingly. See PBS/RPBS Restricted 
Benefit Medications for further information.

https://www.medicaldirector.com/help/topics-clinical/Drug_Quantity,_Duration_and_Repeats.htm
https://www.medicaldirector.com/help/topics-clinical/Drug_Quantity,_Duration_and_Repeats.htm
https://www.medicaldirector.com/help/topics-clinical/Prescribing_Options.htm
https://www.medicaldirector.com/help/topics-clinical/PBS_RPBS_Restricted_Benefit_Medications.htm
https://www.medicaldirector.com/help/topics-clinical/PBS_RPBS_Restricted_Benefit_Medications.htm
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Prescribing

• Active check box. Ticking this check box will save the Reason for Prescription to the patient's Past History tab and flag it 
as an active condition.

• Confidential check box. Ticking the Confidential check box prevents the item from being printed on letters, 
Pathology/Radiology requests, or in printed history summaries for the patient's chart. It is provided so that sensitive items 
(e.g. termination of pregnancy) will not appear on a referral for an eye examination, for example.

• Summary check box. The Summary check box allows items to be marked as summary items. They will appear on 
printed summaries and on letters/request forms (provided they have not been marked as Confidential). If not marked as a 
summary item, the item will appear on-screen, but will not appear on any printed output. This prevents the printed 
summaries, letters and request forms from becoming too lengthy with relatively trivial entries i.e. only items of significant 
importance in the patient's Past History should be marked as Summary items.

28. Click OK button when you are ready to continue.

29. The Select Drug window reappears, awaiting further prescriptions (this functionality can be disabled via Prescribing 
Options).

o Proceed with the prescribing of further items if you wish, or click Close to cease.

o Prescriptions that you have added now appear within the patient's Current Medications List (Current Rx tab), and are 
flagged as ready for printing.

    30. Print scripts as required.

27. The Reason for Medication window appears, prompting you to record a reason for the medication. This is optional, so if you wish not to record a reason click Close. See also the Diagnosis Coder.

If you choose to enter a reason, either;

o Pick a hard-coded reason by typing the first few letters of the reason into the Pick from List (Coded) text box, and then selecting the reason from those that appear in the corresponding list, or

o Enter a custom reason by selecting the Free Text (Uncoded) option and then typing the reason into the corresponding text box, or

o Select an existing reason from the Existing Past Medical History Items list.

o The following options are also available from this window:

• Save in Past Medical History check box. Ticking this check box will save the Reason for Medication to the patient's Past History tab. Enabling this check box also makes available the Active, Confidential and Summary check 
boxes.

• Save as Reason for Contact check box. Ticking the Save as Reason for Contact check box will add a corresponding note to the patient's Progress Notes.

• Left and Right check boxes. The Left and Right check boxes allow items to be marked as either on the left side of the body, right side of the body or by ticking both, bilateral.
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Paperless Electronic Prescribing

You can indicate whether the patient wants the medication to appear 
on their active script list.

When an item is marked as 'Script Owing' on the Enter Dose window, 
only paper tokens will be permitted (no SMS or email).

https://www.medicaldirector.com/resources/eprescribing-and-active-ingredient-prescribing-in-medicaldirector-helix-and-clinical
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Paperless Electronic Prescribing

When an item is a Schedule 8 (S8) medication, you will 
be prompted for an approval / authority / warrant / 
permit number.

o When an item is a Schedule 4B (NSW) or Schedule 4D (TAS) 
medication (e.g. TESTOSTERONE CREAM), altering the number of 
repeats activates the 'Days between repeats' field on the 'Drug 
Quantity & Repeats' window. This is existing behaviour for S8 items 
but was expanded to include the S4B and S4D.
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Paperless Electronic Prescribing

The Prescription Preview window additionally provides the 
options to SMS or Email an electronic token or print a paper 
token.

• A suggested delivery method will be preselected for 
you. This selection is determined by information found in the 
patient's record, with priority going to SMS followed by 
Email and then Printed media.

If the user has specified a Prescriber Type other than 
'Medical Practitioner' or 'Nurse', and their state is either ACT 
or SA, 'Restricted Use For' information appears on 
prescriptions.

SMS fees are subsidised until 31 July, 2027.
Please enable SMS via Settings > Centre, before 
government subsidies expire, to continue to provide 
patients with SMS prescription delivery.

https://www.medicaldirector.com/help/topics-clinical/Pt_Details_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Pt_Details_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Adding,_Editing_and_Deleting_Practitioners_and_Nurse_Practitioners.htm
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Keeping Medications Current 

Once Real Time Prescription Monitoring is enabled, the 
practitioner will be prompted with the Real Time Prescription 
Monitoring warning when S8 drugs and other high risk 
medicines such as benzodiazepines, zolpidem or zopiclone, 
quetiapine and codeine are prescribed.

Real Time Prescription Monitoring Notifications

The practitioner will get a Real Time Prescription Monitoring 
prompt after performing the following on any S8 drugs and 
other high risk medicines such as benzodiazepines, zolpidem or 
zopiclone, quetiapine and codeine.

o When adding drugs to the Current Rx tab.

o When Changing ‘Dose’ in Current Rx tab

o When Changing ‘Quantity’ in Current Rx tab

o When Changing ‘Strength’ in Current Rx tab

o When re-prescribing a current high-risk medication via the 
patient's Old Scripts Tab

See Managing and Modifying Current Prescriptions

https://www.medicaldirector.com/help/topics-clinical/Current_Rx_(Medications)_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Old_Scripts_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Managing_and_Modifying_Current_Prescriptions.htm
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Keeping Medications Current 
A GREEN notification will appear in the following situations:

o When there has not been a prescription issued/dispensed for a monitored medicine in the last 6 months or

o When prescriptions for a monitored medicine in the last 6 months have been issued by the same prescriber/medical practice, and there are no alerts

When use of Real Time Prescription Monitoring becomes mandatory, prescribers/pharmacists will not be required to click on the notification to review the patient history.

An AMBER notification will appear in the following situations:

o When prescriptions for a monitored medicine in the last 6 months have been issued by more than one prescriber/medical practice or

o When the daily morphine equivalent dose (calculated based on an average over the last 90 days) is between 50mg and 100mg MED daily (i.e. a medium risk dose)

When use of Real Time Prescription Monitoring becomes mandatory, prescribers/pharmacists will be required to click on the notification to review the patient history to 
assess whether it is safe or appropriate to prescribe/dispense a medicine.

A RED notification will appear in the following situations:

o Patient has active alerts within the last 3 month (90 days)

A RED notification will appear when there is a current alert relating to the prescribing/dispensing history of a patient.

These alerts are:

o Multiple provider episodes: When prescriptions from 4 or more prescribers/medical practices or 4 or more pharmacies have been recorded in Real Time Prescription 
Monitoring within the last 90 days.

o High-risk drug combinations: When prescriptions for certain drug combinations have been recorded in Real Time Prescription Monitoring within the last 90 days.

• Methadone + a benzodiazepine

• Methadone + a long-acting opioid

• Fentanyl + a benzodiazepine

• Fentanyl + a long-acting opioid

o Opioid dose threshold: When the daily morphine equivalent dose (calculated based on an average over the last 90 days) exceeds 100mg MED daily (i.e. a high risk 
dose).

When use of Real Time Prescription Monitoring becomes mandatory, prescribers/pharmacists will be required to click on the notification to review the patient history to 
assess whether it is safe or appropriate to prescribe/dispense a medicine.

https://www2.health.vic.gov.au/public-health/drugs-and-poisons/safescript/health-professionals
https://www2.health.vic.gov.au/public-health/drugs-and-poisons/safescript/health-professionals
https://www2.health.vic.gov.au/public-health/drugs-and-poisons/safescript/health-professionals
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Reviewing Results via Holding file
Holding File for All Patients

1. Select Correspondence > Check Holding File (All Patients).

2. You will be prompted to select one or more recipients whose results you wish to 
examine.

3. From this window select the recipient(s) whose results you wish to examine:

o Select a single recipient by clicking their name, and then clicking OK to open the 
Holding File to display only their results. Alternatively you can double-click a name to 
simultaneously select them and open the Holding File.

o Select multiple recipients by clicking each name. To deselect a name, simply click 
it again. Then, click OK to open the Holding File to display only the results of the 
selected recipients.

o Select all recipients by clicking the All Recipients option. Clicking OK then opens 
the Holding File to display results for all recipients. Alternatively you can double-click 
the All Recipients option to simultaneously select all recipients and open the Holding 
File.

Note that, as making a selection from this window locks the results associated with 
the selected recipient, it is recommended that you select only a specific recipient, as 
selecting All Recipients will prevent others from accessing any results whilst you have 
the Holding File open.

4. You will then be presented with the Holding File.

5. (Optional) Upon opening the Holding File, the first result in the list is 
automatically selected and displayed. If Clinical cannot determine which patient the 
result relates to, you will be prompted to either add a new patient to the database (by 
clicking Add New button, or select from a list of patients the result could possibly     
belong to, as seen in the following example.

6. Within the Holding File you can check-off Results. See Checking Off New Results for 
information.

7. Review the table below for information on using the Holding File.

See Filtering/Searching Correspondence Records for more information.

https://www.medicaldirector.com/help/topics-clinical/Filtering_Results_in_the_Holding_File.htm
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Recording Social and Family History

Data recorded here is available to the Letter Writer where it 
can be merged into letters and e-mail correspondence. Family 
History and Social History data will also appear on 
the Summary tab.

Item Criteria

ADF Service Indicate the patient's service (if any) with the Australian Defence Force.

A patient's service status;

•Is displayed within the Occupation field located towards the top of 
the Clinical Window.

•May affect whether you are prompted to perform an assessment for 
them upon opening their clinical record.

Update 
Address for All 
Family 
Members        
check box

Update the address details for other family members, with the details 
of the current patient. Clinical uses the Head of Family. setting to 
determine which patients are members of the same family. This option 
is only available when editing Patient Details from the Clinical Window.

Auto-
Capitalise 
Names check 
box

Tick the Auto-Capitalise Names check box to automatically capitalise 
the first letter of each word you type. There are numerous windows 
throughout MedicalDirector Clinical that offer this functionality, 
including the various Options tabs.

https://www.medicaldirector.com/help/topics-clinical/Summary_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/Prompt_Preventive_Health_Criteria.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/Options.htm
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Recording Alcohol
The AUDIT-C assessment can help identify persons who are hazardous drinkers or have active alcohol use 
disorders (including alcohol abuse or dependence). The AUDIT-C is a modified version of the 10-question 
AUDIT instrument. The AUDIT-C is scored on a scale of 0–12. Each AUDIT-C question has five answer choices. 
Points allocated are:

a = 0 points           b = 1 point            c = 2 points              d = 3 points           e = 4 points

o In men a score of 4 or more is considered positive, optimal for identifying hazardous drinking or active 
alcohol use disorders.

o In women a score of 3 or more is considered positive (same as above).

The recording of data on this tab is for your records only; it plays no part in the functioning of other modules 
within Clinical, except for the Letter Writer where some of this information can be merged into letters.

•Click View Alcohol Guidelines to open a window of information on alcohol consumption.
•Click Reference to open the World Health Organisation's web page 'Screening and brief intervention for 
alcohol problems in primary health care'.
•Click New Assessment to record a new assessment. This clears data from the window, ready for your new 
assessment. Once you completed the assessment, click Save to save the data. A new entry will be added to 
the list of assessments, located at the top-right of this window.

• A note is also added to the patient's Progress Notes.
• Information you save here is reflected in the patient's Health Assessment, and ATSI Health 

Assessment (for eligible patients).
• The latest assessment is always displayed by default when you access the Alcohol tab.

•To view a previous assessment, locate and double-click a previous assessment from the list at the top-right 
of this window.
•Click Delete to delete a previous assessment.
•Update Address for All Family Members check box: Update the address details for other family members 
with the details of the current patient. Clinical uses the Head of Family setting to determine which patients 
are members of the same family. This option is only available when editing Patient Details from the Clinical 
Window.
•Auto-Capitalise Names check box:Tick the Auto-Capitalise Names check box to automatically capitalise the 
first letter of each word you type. There are numerous windows throughout MedicalDirector Clinical that 
offer this functionality, including the various Options tabs.

https://www.medicaldirector.com/help/topics-clinical/Letter_Writer.htm
https://www.medicaldirector.com/help/topics-clinical/Alcohol_Tab.htm#Alcohol_Guidelines
http://www.who.int/substance_abuse/activities/sbi/en/
http://www.who.int/substance_abuse/activities/sbi/en/
https://www.medicaldirector.com/help/topics-clinical/Progress_Notes.htm
https://www.medicaldirector.com/help/topics-clinical/Health_Assessment.htm
https://www.medicaldirector.com/help/topics-clinical/Aboriginal_and_Torres_Strait_Islander_ATSI_Health_Assessment.htm
https://www.medicaldirector.com/help/topics-clinical/Aboriginal_and_Torres_Strait_Islander_ATSI_Health_Assessment.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/Options.htm
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Recording Smoking

The recording of data on this tab is for your records only; it plays no 
part in the functioning of other modules within Clinical, apart from 
the Letter Writer where this information can be merged into letters.
Click View Patient Education Leaflet to open a pre-selected PDF 
leaflet entitled 'Smoking - Quitting'. This leaflet is one of 
many Patient Education leaflets available.

Smoking cessation intervention discussed with patient check 
box: Ticking this box flags patients for the Smoking Cessation 
report found in MedicalDirector Insights.

Update Address for All Family Members check box: Update the 
address details for other family members, with the details of the 
current patient. Clinical uses the Head of Family. setting to 
determine which patients are members of the same family. This 
option is only available when editing Patient Details from 
the Clinical Window.

Tick the Auto-Capitalise Names check box to automatically 
capitalise the first letter of each word you type. There are 
numerous windows throughout MedicalDirector Clinical that offer 
this functionality, including the various Options tabs.

https://www.medicaldirector.com/help/topics-clinical/Letter_Writer.htm
https://www.medicaldirector.com/help/topics-clinical/Patient_Education_Leaflets.htm
http://test.medicaldirector.com/help/insights/about_insights.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/Options.htm
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Recording Allergies/Adverse Reactions/Warnings

Items of Interest on this window

No 

Known Allergies / 
Adverse Reactions

By ticking this check box you will remove and delete all currently-recorded known allergies and/or drug 
reactions for this patient. This happens immediately upon ticking the check box, and is not reversible.

Warnings Section
Add free-text warnings to this section. Warnings added will be visible at the top-left of the patient's 
Clinical Window.

Drug dependent

Ticking this check box will;

•Insert an entry into the 'Actions' header of the current Progress Note.

•Display "Drug Dependent" on the Warning section in the patient's record.

Elite Sportsperson This provides warnings when prescribing drugs that are banned in sport.

Breast Feeding The Breast Feeding check box only appears for female patients within the configured age group.

Update Address for 

All Family 
Members

Update the address details for other family members, with the details of the current patient. Clinical uses 
the Head of Family. setting to determine which patients are members of the same family. This option is 
only available when editing Patient Details from the Clinical Window.

Auto-Capitalise 

Names

Tick the Auto-Capitalise Names check box to automatically capitalise the first letter of each word you 
type. There are numerous windows throughout MedicalDirector Clinical that offer this functionality, 
including the various Options tabs.

F7  or Allergies/Warnings (via the Clinical Window) 

1. Select the Allergies/Adverse Reactions/Warnings tab within the Patient Details window. 
2. Click Add The Add Allergy / Adverse Reaction window appears.
3. Add the source of the allergy: 
•Enter Allergy by Drug
•Enter Allergy by Class
•Enter Allergy by Other: Allows you to free-type an allergy not necessarily related to a particular drug or class. You can also use this option to 
be more specific. For example if you wanted to record an allergy to EXELON you would normally use the 'By Drug' option and simply look for 
EXELON. However, if the patient was allergic to only the patch variety of EXELON, you could use the 'Other' option instead, and enter 
'EXELON Patch’.

4.  Describe the nature of the reaction. 
5.  Indicate the Type of reaction
6.  Indicate the Severity of the reaction. 
Click OK to confirm your input. Allergies added will be visible at the top-left of the patient's Clinical Window. 
To view a percentage of patients who have not been asked about their allergy/adverse reaction status, see Patient's with Non-Entered 
Clinical Data. You can also print a list of patients from this search utility.

https://www.medicaldirector.com/help/topics-clinical/Progress_Notes.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/Options.htm
https://www.medicaldirector.com/help/topics-clinical/Adding_Allergies_by_Drug.htm
https://www.medicaldirector.com/help/topics-clinical/Patients_with_Non-Entered_Clinical_Data.htm
https://www.medicaldirector.com/help/topics-clinical/Patients_with_Non-Entered_Clinical_Data.htm


TELSTRA HEALTH INTERNAL

Recording reason for visit
The Reason for Contact module allows you to enter a diagnosis into the Progress Notes, 
using the DOCLE coded list of conditions that is also used in the Past Medical 
History section of Clinical.

1.Select the Progress tab in the patient's clinical record.

2.Click Reason button. The Reason for Contact window appears.

3.Enter the first few letters of the procedure name in the Pick from List (uncoded) text 
box. A list of procedures that start with the letters entered is displayed. The list of 
procedures changes dynamically as text characters are entered or deleted. Alternatively 
you can select from previous procedures or conditions listed in the Existing Past Medical 
History Items list.

4.Double-click the required item from the list of choices. Alternatively you can either select 
from previous procedures or conditions listed in the Existing Past Medical History 
Items list or free-type a Reason for Contact into the Free Text text box.

5.Optional Modifications:

• By default the procedure is marked as Active. To change this, clear the Active check box.

• Select either Left or Right or both to mark whether the procedure is for the Left, Right 
or both sides.

• By default, the check boxes are set so the record is saved in the Past Medical History list 
and as the primary Reason for visit. Clear these check boxes if required.

• To list this procedure on printed letters and summaries, select the Summary check box.

https://www.medicaldirector.com/help/topics-clinical/Progress_Notes.htm
https://www.medicaldirector.com/help/topics-clinical/Past_History_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Past_History_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Progress_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
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Keeping Past History items relevant

The Past History tab displays a summary of the 
patient's medical history. This is not to be confused with 
a patient's clinical progress, as recorded via Progress 
Notes.
Coded: Indicates if the diagnosis was made by selecting 
from the DOCLE list of diagnosis.

Comment: Displays comments relating to a given past 
history entry. This window is read-only.

Types of History Records: Filter the past history records 
by All Records, Active, Inactive (displayed in grey), or 
Summary

No Significant Past History: If the patient has no 
significant clinical history to make a note of, indicate this 
by ticking this check box. A prompt to remind you to 
check this status with your patient is managed from 
within Prompt/Preventive Health Options. To view a 
percentage of patients who have not been asked about 
their past history status, see Clinical Data Statistics. You 
can also print a list of patients from this search utility.

When viewing all records, inactive items are displayed in grey.

https://www.medicaldirector.com/help/topics-clinical/Adding,_Editing,_and_Deleting_History_Items.htm
https://www.medicaldirector.com/help/topics-clinical/Progress_Notes.htm
https://www.medicaldirector.com/help/topics-clinical/Progress_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Progress_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Prompt_Preventive_Health_Options.htm
https://www.medicaldirector.com/help/topics-clinical/Patients_with_Non-Entered_Clinical_Data.htm
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Removes a selected document from the My Health Record system. This is only available if you are the 
creator of the original document, or it was created by another user from the same Practice (i.e. with 
the same Practice HPI-O recorded via Tools > Options > Practice tab.

My Health Record accessing
With Clinical configured correctly, you can access a patient's My Health Record 
documentation via the My Health Record menu within the patient's Clinical 
Window. You will be presented with the My Health Record window, an example 
of which is shown below.

Note that when you first access the My Health Record system, you will be 
prompted to complete your user name details. You will only be asked this once.

Allows you to gain access to documents that have been password-protected by 
the patient - it is the patient who controls access to their My Health Record 
documentation.

Any document can be applied one of two access levels;

•Open: the document is unrestricted.

•Code: the document requires an access code to view/download.

Click the Change/Gain Access button, and then select from the three Access 
Type options;

•Open Access: no access code required.

•Access Code: enables the Access Code field in which you must enter the access 
code the patient provided you.

•Emergency: grants you access to password-restricted documents for five days. 
To be used in an emergency when the patient cannot be contacted. A record of 
the document being accessed in this fashion may be sent to the patient.

https://www.medicaldirector.com/help/topics-clinical/Practice_Options.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
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My Health Record accessing Prescription & Dispense 

The Prescription and Dispense View tab 
lists prescribed/dispensed medications 
that the patient has granted consent to 
upload to the My Health Record System. 
Consent is typically indicated via the 
Enter Dose window during 
the prescribing process, but can also be 
granted/revoked afterwards by right-
clicking an item on the CurrentRx tab and 
clicking the My Health Record Consent 
entry from the menu that appears. This 
functionality requires that you have 
enable ePrescribing.
To view a medication on this window;
1. First, expand the medication details 
by clicking the   button at the far left 
end of the medication row.
2. Secondly, click the medication 
details. The script details will be revealed

https://www.medicaldirector.com/help/topics-clinical/Creating_New_Prescriptions.htm
https://www.medicaldirector.com/help/topics-clinical/Current_Rx_(Medications)_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/ePrescribing_Configuration.htm
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My Health Record accessing Pathology Report
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My Health Record accessing Diagnostic Imaging Report
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My Health Record uploading while Prescribing

With a patient’s consent, prescriptions can be uploaded to their My Health 
Record. The upload occurs automatically when you print a script. Consent is 
typically indicated via the Enter Dose window during the prescribing process, 
but can also be granted/revoked afterwards by right-clicking an item on 
the CurrentRx tab and clicking the My Health Record Consent entry from the 
menu that appears.

The National Prescription and Dispense Repository (NPDR) is a subset of a 
patient’s My Health Record and allows for the creation of an online medication 
history (for both prescriptions and dispensing). Transfer of medications in this 
way requires you are registered for ePrescribing and have enabled eRx Script 
Exchange.

Prerequisites:
o Practitioner is registered for ePrescribing. See ePrescribing 
Configuration for instructions.

o My Health Record is configured correctly. See Configuring 
MedicalDirector Clinical for My Health Record for instructions.

o Practitioner has indicated their participation in My Health 
Record. See below for details.

For further information regarding the NPDR, please refer to the following link:

www.ehealth.gov.au/internet/ehealth/publishing.nsf/Content/faqs-hcp-
managing#anchor11

https://www.medicaldirector.com/help/topics-clinical/Creating_New_Prescriptions.htm
https://www.medicaldirector.com/help/topics-clinical/Current_Rx_(Medications)_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/ePrescribing_Configuration.htm
https://www.medicaldirector.com/help/topics-clinical/ePrescribing_Configuration.htm
https://www.medicaldirector.com/help/topics-clinical/MyHealthRecord.htm#Configuring_Medical_Director_for_PCEHR
http://www.ehealth.gov.au/internet/ehealth/publishing.nsf/Content/faqs-hcp-managing#anchor11
http://www.ehealth.gov.au/internet/ehealth/publishing.nsf/Content/faqs-hcp-managing#anchor11
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My Health Record uploading Documents

1. Create a CDA document via one of the supplied 
e-Health templates in Letter Writer.

2. Then, within the patient's record, locate the 
document you wish to upload. Documents can 
reside on either of 
the Correspondence, Documents, Results or Letters
tabs.

3. Click Send To MyHealthRecord button.  You will 
be presented with a preview of the document.

4. If you are satisfied that this is the document you 
wish to upload, click Send on the preview window.

5. The upload will commence and you will be 
notified upon completion. The 'My Health Record 
Status' and 'My Health Record Activity Date' 
columns within the correspondence tabs of the 
patient's record will indicate the selected 
document's My Health Record status.

https://www.medicaldirector.com/help/topics-clinical/Creating_CDA_e-Health_Documents.htm
https://www.medicaldirector.com/help/topics-clinical/Letter_Writer.htm
https://www.medicaldirector.com/help/topics-clinical/Correspondence_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Documents_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Results_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Letters_Tab.htm
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My Health Record Saving, Superseded or Removed

1. Within the patient's record, select the My Health Record 
menu. You will be presented with the My Health Record 
window.

2. Locate and select the document you wish to download.

3. Click Save in MD button. 

o If the document is of type 'Shared Health Summary' or 
'Event Summary' it is saved to the Documents tab of the 
patient record. Documents of type 'e-Referral' or 'Specialist 
Letter' are saved to the Letters tab.

o If the document already exists in the patient's record (it 
has already been downloaded from My Health Record), you 
will be notified accordingly.

o If the document already exists in the patient's record, but 
on the My Health Record system there is a newer version of it, 
the document will be downloaded to the patient's record, and 
the older version will be retained within the patient's record 
for historical purposes.

o The 'My Health Record Status' and 'My Health Record 
Activity Date' columns within the Documents/Letters tabs will 
indicate the selected document's My Health Record status, 
such as 'Uploaded', 'Downloaded', 'Superseded', or 'Removed'.

https://www.medicaldirector.com/help/topics-clinical/Documents_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Letters_Tab.htm
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Patient's Record
· Add Progress Notes from anywhere in the 
patient workflow, via a new floating panel.
· Added 7 new Quick Template buttons 
which can be configured as website links or 
quick launch buttons.
· Keyboard shortcuts are now highlighted 
with an underscore, and new shortcuts have 
been added.
When opening the Holding File from within a 
patient's record, the data is filtered 
automatically to show results for the selected 
patient.
· The web URL links in the CVD
Risk Assessment screen have been updated to 
more modern resources.

Prescribing
· You can now search for a drug based on 
the characters in the search box existing 
anywhere in the drug name rather than just at 
the beginning.

· When an Electronic Paperless 
Prescription with repeats is cancelled 
after the original has been dispensed, 
the repeats are now also cancelled.

Email
· Email attachments are now in 
PDF format.
· Email attachments can now be 
password protected.
· Send email directly from the 
patient's record.
· The email configuration menu has 
been moved to Correspondence > 
Email for ease of access.
· Create and configure custom 
email templates for quick reuse.
Improved the loading speed of the 
holding file when many results are 
present.

4.3 New Enhancements 
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Introducing Telstra Health Smart Clinician – a reimagined suite of healthcare 
management tools for General Practitioners and Practice Managers.
This all-inclusive ecosystem empowers medical professionals with a 
comprehensive suite of tools designed to streamline every aspect of their practice.
From Visual Dashboards that provide at-a-glance insights into patient health 
trends, to Telehealth capabilities that enable virtual consultations, and a Patient 
Portal ensuring seamless patient engagement. With additional features like 
Program Finder, Care coordination, Clinical Support, Communications, and 
Research tools, Telstra Health Smart Clinician stands as an indispensable asset for 
modern healthcare.

https://www.telstrahealth.com/products/telstra-health-smart-marketplace/
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Smart Bar - Tools available in Smart Clinician

Smartbar 

Smartbar by Telstra Health is the latest innovation in MedicalDirector 
Clinical. With a suite of healthcare tools and widgets, it makes the 
lives of GPs and Practice Managers more efficient and effortless

Email: ecosystem.solutions@medicaldirector.com

mailto:ecosystem.solutions@medicaldirector.com
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FAQ’S

Q1. Trouble shooting uploading shared summaries to my health record. Why do some not work?

Answer: 

Regarding the issue with viewing Discharge summaries\Uploading to My Health Record, please do the following;Press the 
Windows key and R
•Browse to; C:\windows\assembly\GAC_32 (you can only get there by browsing)
Add:
•C:\Windows\Microsoft.NET\assembly\GAC_32\Hcn.Cda.Generator\v4.0_1.0.0.0__d6b06804ccddbb90\Hcn.Cda.Generator.
dll
•C:\Program Files (x86)\Health Communication Network\Medical Director\Plugins\Hcn.Sidebar.Plugin\FiddlerCore.dll
In the Sophos dashboard, please add the general exception and exceptions for each individual PC as well.

Each of the DLLs may require re-application after this has been applied.
May require a repair of the MedicalDirector National eHealth plugins and the MedicalDirector sidebar plugin
Open Control Panel > Programs and features
Find the program and right click and repair

Check Firewall Rules for MedicalDirector Software

Antivirus Exceptions for MedicalDirector Software
Environmental Configurations for MedicalDirector Services

https://microsoft.net/
https://medicaldirector.lightning.force.com/lightning/r/Knowledge__kav/ka02e0000001Gs0AAE/view
https://medicaldirector.lightning.force.com/lightning/r/Knowledge__kav/ka02e00000016njAAA/view
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Your Support Team

Unlimited Support 7 days a week

With one of the largest customer support teams in the industry, we 
offer software support when you need it.

Our team can be contacted 7 days a week via phone or live chat 
available on our website.

Product Consultants for Knowledge & Training

We take pride in the tenure, experience and knowledge of the 
customer service consultants that offer a unique level of 
understanding of your practice.

1300 300 161
medicaldirector.com/contact-us

8am – 6pm AEST Mon to Fri
9 – 5pm AEST Weekends
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Contact
E: info@emphn.org.au 

P: (03) 9046 0300

emphn.org.au

digitalhealth@emphn.org.au
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MedicalDirector Resources

Clinical and Pracsoft version 4.3: The latest upgrade of Telstra Health’s GP software
Harnessing the power of your practice data
Introducing MedicalDirector Care – Making Care Plans easy
Preparing your practice for ePrescribing
Introducing Telehealth in MedicalDirector Clinical

MyMedicare resources:

Australian Government Department of Health and Aged Care – MyMedicare
MyMedicare webinar – 22 August 2023 | Australian Government Department of Health and Aged Care
Services Australia MyMedicare Learing Resource
Services Australia Checklist and steps to register for MyMedicare on the Organisation Register
Information for patients on MyMedicare – Australian Government Department of Health and Aged 
Care
MyMedicare – Health Professional Education Resources
MyMedicare – Overview
MyMedicare – Managing patient registrations
MedicalDirector Clinical and Pracsoft version 4.3 upgrade
MyMedicare Import Wizard for Clinical version 4.3

https://www.medicaldirector.com/news/future-of-health/clinical-and-pracsoft-version-4-3-the-latest-upgrade-of-telstra-healths-gp-software/
https://www.medicaldirector.com/resources/harnessing-the-power-of-your-practice-data
https://www.medicaldirector.com/resources/introducing-medicaldirector-care-making-care-plans-easy
https://www.medicaldirector.com/resources/preparing-your-practice-for-eprescribing
https://www.medicaldirector.com/resources/introducing-telehealth-in-medicaldirector-clinical
https://www.health.gov.au/our-work/mymedicare
https://www.health.gov.au/resources/webinars/mymedicare-webinar-22-august-2023?language=en&mc_cid=d696c12a00&mc_eid=9fd0a8e04c&utm_source=hs_email&utm_medium=email&_hsenc=p2ANqtz-_8d8lQ-LagM3qJBHbqrgIGXdeXFPPg7UsORv88tonauZP0R8uB9uAEtXI7C2-QL6ZUZzx9
https://hpe.servicesaustralia.gov.au/MODULES/MYMED/MYMEDM01/index.html
https://hpe.servicesaustralia.gov.au/INFO/MYMED/MYMEDINFO1.pdf
https://www.health.gov.au/our-work/mymedicare/patients
https://www.health.gov.au/our-work/mymedicare/patients
https://hpe.servicesaustralia.gov.au/mymedicare.html
https://hpe.servicesaustralia.gov.au/MODULES/MYMED/MYMEDM01/index.html
https://hpe.servicesaustralia.gov.au/MODULES/MYMED/MYMEDM02/index.html
https://www.medicaldirector.com/upgrade/clinical-pracsoft
https://www.medicaldirector.com/help/#t=topics-maintenance%2FMyMedicare_Import_Wizard.htm
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Upcoming Webinars

Dates: Time: Location: Enquiries: 
Thursday 8 August 2024 12pm - 
2pm Online webinar Digital Health 
digitalhealth@emphn.org.au

Dates: Time: Location: Enquiries: 
Wednesday 7 August 2024 12pm - 
2pm Online webinar Digital Health 
digitalhealth@emphn.org.au 

MedicalDirector Training for 
Clinical Nurses 

MedicalDirector Training for 
Advanced Practice Managers

Register using the QR code or visit 
www.emphn.org.au/newsevents/events/detail/25924

Register using the QR code or visit 
www.emphn.org.au/newsevents/events/detail/25920
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Thank you
A recording & slides of this session and 
feedback form will be delivered to your inbox 
shortly.

Kylie Goodwin
Practice Consultant 
MedicalDirector | Telstra Health
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